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Overview

This chapter covers the following topics:

Introducing HP Performance Insight

Data Collection for the Database Report Pack
Database Reports

Thresholds and Integration with HP Operations/OM
Thresholds and Integration with HP Operations/OM
Options for Customizing Reports

Sources for Additional Information

Package Version History

Introducing HP Performance Insight

Performance Insight collects data from many sources, performs in-depth trend analysis,
maintains performance baselines, and provides users with convenient, web-based reporting.
Following is a partial list of product features:

Distributed architecture

Easy to scale (supports data collection from thousands of agents)
Supports CODA/PA agents

Multi-company security model

Data warehousing

Near Real Time reporting

Forecasting

Extensive aggregation options (by hour, day, week, month; by location, by customer)
Thresholding and alerting

Easy identification of bottlenecks

Easy assessment of capacity trends

Accurate and timely documentation for management
Integration with NNM

Integration with Operations Manager



Many reporting solutions have been created for Performance Insight and new solutions are
added every year. The newest solutions, released October 2007, are Business Process Insight
and SiteScope Integration. For a complete list of reporting solutions organized by technology,
see Appendix A, PI Report Packs.

Data Collection for the Database Report Pack

The only datapipe used by the Database Report Pack is the Database Oracle SPI Datapipe.
The Database Oracle SPI Datapipe collects data from the Embedded Performance Agent, a
sub-agent that ships with HPOW 7.20+ and HPOU 7.20+. The Database Oracle SPI Datapipe
does not collect data from earlier versions of HP Operations/OM.

The Database Oracle SPI Datapipe polls the EPC data store once every 45 minutes. Because
changing the polling frequency could interfere with the polling conducted by PI for the System
Resource Report Pack, we recommend that you do not change the polling frequency.

The following table provides a list of metrics polled by the Database Oracle SPI Datapipe.

Metric Description | metricid | objectid valueid | value
E201_InstUptime Availability 201 Instance name 1 Up=5
Down =0
E212_InstSize Instance size 212 Instance name 1 Megabytes allocated
E212_InstSize Instance size 212 Instance name 2 Megabytes free
E210_TblSpcSize Tablespace size | 210 Table space name | 1 Megabytes allocated
E210_TblSpcSize Tablespace size | 210 Table space name | 2 Megabytes free
E215_SegmntSize Segment size 215 Segment name 1 Megabytes allocated
E213_TblSpclO Tablespace I/0 | 213 Table space name | 1 Physical
reads+writes since
last collection
E037_USERLOGONCNT | User logons NA NA NA Number of user
logons
NAE044 COMMITRATE | Transactions NA NA NA Number of
transactions

Future releases of the Database Report Pack will provide datapipes designed for:
e Sybase

¢ Informix

e MS SQL Server

e MS Access
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Database Reports

Overview

The reports in the Database Report Pack perform a ranking function, allowing you to compare
database instances, spot various kinds of problems before they become serious, and anticipate
capacity issues. Reports provide easy access to the following information:

e Dynamic space usage over the previous week

¢ Daily fluctuations in instance-size-free vs. instance-size-used

e Logon activity for the last few hours, per instance

e Availability for the last few hours, per instance

e Number of transactions for the last few hours, per instance

e Details about each customer (uptime, downtime, instance size, logons)
e Details about each location (uptime, downtime, instance size, logons)
e Segment analysis (Oracle only)

e Tablespace analysis (Oracle only)

The Database SPI Report Pack offers the following features:

e Report linking

¢ Launch Point page

¢ Ad hoc selector reports

¢ Color-coded graphics in selection tables

Report linking means that navigating reports is more like navigating a website. You have
numerous links to follow and investigating a specific area of interest is easier and more
efficient. Use the links to move quickly between reports — there is no need to close the report
you are viewing and then navigate folders. In addition to moving from one report to another
report within the same report pack, you can link to reports in a different report pack. For
example, there are links in Database reports that will open reports in the Device Resource
Report Pack.

The Launch Point page groups reports into categories, providing a convenient overview of the
package. The Database Report Pack includes two Launch Point pages, one for generic reports
and one for Oracle reports. The generic Launch Point page offers the following choices:

Seneric Seneric
History rMear Real
Feports Time
Reports
Customer Ad-Hoc
and selector and
Location Cluick wiew
aggregation Reports
Feports

Dracle Reports
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The Oracle Launch Point page offers two choices:

Segment Tablespace
Based Based
Reports Reports

The ad hoc selector option opens a report that lets you select specific devices and interfaces
from a set of drop-down menus. Use the drop-down menus to pinpoint an item of interest. You
will notice that the report displays quickly. Response time is good due to the limited number of
database queries.

Categories and Reports

The following table provides a list of the reports in each category.

Category Reports

Generic History Instance Size Details

Instance Size History

Generic NRT Instance Availability NRT
Instance Transactions NRT
Instance Logons NRT

Customer and Location Customer Summary

Location Summary

Adhoc Selector and QuickView | Instance QuickView
Ad hoc Instance Selector

Oracle Segment Segment Size Details
Segment Size History

Oracle Tablespace Tablespace Size Used Top 20
Tablespace Size Allocated Top 20
Tablespace Size Percentage Used Top 20
Tablespace Size History

Tablespace Physical I/0 Top 20
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Reports and Statistics

Overview

The following table outlines the statistics available in each report. For information about how

each statistic is calculated, see Appendix B, Formulas.

Report

Statistics

Instance Size Details

Instance size allocated
Average instance size used

Average instance size free

Instance Size History

Instance size allocated
Instance dynamic size usage
Average instance size free

Instance Availability NRT

Total instance uptime
Total instance downtime
Total instance unknowntime

Instance Transactions NRT

Number of transaction
Maximum transactions
Minimum transactions

Average transactions

Instance Logons NRT

Total logons
Maximum logons
Minimum logons

Average logons

Customer Details

Total uptime
Total downtime
Total instance size free

Total instance logons

Average instance size percent used

Location Details

Total uptime
Total downtime
Total instance size free

Total instance logons

Average instance size percent used

Instance QuickView

Instance availability NRT details

Instance size usage trend
Average logon trend
Average transaction trend

Adhoc Instance Selector

Average instance uptime
Average instance logons
Average instance transactions

Average instance percentage size used




Report

Statistics

Segment Size Details

Total segment size allocated (MBs)

Segment Size History

Average size allocated
Dynamic size allocation
Segment size allocation details

Tablespace Size: Used Top 20

Average megabytes allocated

Average megabytes used

Tablespace Size: Allocated Top
20

Average megabytes allocated
Average megabytes used

Average megabytes free

Tablespace Size: Percentage
Used Top 20

Total space allocated
Percent used

Tablespace usage trend

Oracle Tablespace Size: History

Average size allocated
Dynamic size usage
Average size free

Oracle Tablespace: Physical I/O
Top 20

Total physical I/0
Maximum physical I/O
Minimum physical I/O
Average physical I/0

PA polls the following Tablespace metrics once a day:

e TblSpaceSizeAllocated

e TblSpaceSizeUsed

e TblSpaceSizeFree

e TblSpaceSizePercentUsed
e TblSpaceSizePercentFree
e TblSpacePhysicallO

If the default polling interval is not changed, the values in daily report for total, average,
maximum, and minimum will not be meaningful. To get meaningful data for total, average,
maximum, and minimum, the PA polling frequency must be modified. For help with that step,

refer to PA documentation.

Thresholds and Integration with HP Operations/OM

You can improve your ability to isolate faults and diagnose problems by installing the optional
thresholds sub-package that comes with the Database Report Pack and configuring them
as the destination for breach and clear traps generated by PI. If you install the optional

Chapter 1



thresholds sub-package, the Thresholds Module will monitor the PI database for breach
conditions and respond to breaches by taking one of several possible actions, for example,
sending breach and clear traps to HP Operations/OM.

The thresholds sub-package provides the following defaults:
Instance Availability = 85%
Instance Size Used = 95%

To modify the defaults, open the Instance Customer Location and Threshold Configuration
form. Enter new threshold values and save your changes.

Fi| fadmin/Database_Forms,/DB_Update_Instance.frep

Database Report Pack (ﬁﬂ

Instance Customer Location and
Threshold Configuration

invent

Uze this form to update the properies far a database instance. Here user ¢can change threshold walue and
customer location name for a instance.

Instance

. Instance
size Availability
System Hame Instance Vendor LWHilization Customer Name
Threshold
Threshold )
(%)
ovpintd india . hgp.corm ovpintSd Oracle 55.00 95.00 Customer Unassigned

Rl | i3

Location Hame Location Unassigned w
Instance Size WMilization Threshold (%) 8500
Instance Availability Threshold (%) 95.00
Customer Hame Customer Unassigned w

Because Network Node Manager (NNM) is the default destination for traps, you must
configure the Thresholds Module to send traps to HP Operations/OM. Do this by opening the
SNMP Trap Action Definition form. Fill in the necessary information and save your changes. In
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addition to using the SNMP Trap Action Definition form to configure a new destination for
traps, your HP Operations/OM administrator must prepare a trap template definition. The
Thresholds Module User Guide contains the information needed to prepare the template.

Options for Customizing Reports

The contents of a report can be customized by editing parameters, by editing tables and
graphs, and by modifying default thresholds. Since there are no customer-oriented reports or
location-oriented reports in the Database Report Pack, you cannot use group filters to create
customer-specific reports. For details about editing tables and graphs, see Appendix C,
Editing Tables and Graphs.

Editing a parameter applies a constraint to the contents of the report, thereby eliminating the
data you are not interested in seeing. The Database Reporting Report Pack supports the
following parameters:

e Instance

e System

e Vendor

e Customer

¢ Location

If you are using Report Viewer, follow these steps to edit a parameter:

1 Select Edit > Parameter Values from the menu bar.

2 When the Modify Parameter Values window appears, click the Current Value field.
3 Enter a new value.

4 Click OK.

If you are viewing the report on the Web, follow these steps:

1 Click the Edit icon at the bottom right-hand corner of the report.

2 When the Edit Parameters window opens, type the constraint in the appropriate field.
3 Click Submit.

Sources for Additional Information

For information about the latest enhancements to this package, and any known issues, refer
to the Database Report Pack Release Notes.

Manuals for the core product, Performance Insight, and manuals for the reporting solutions
that run on Performance Insight can be downloaded from here:

http:/h20230.www2.hp.com/selfsolve/manuals

The user guides for PI are listed under Performance Insight. The user guides for report packs
and datapipes are listed under Performance Insight Report Packs. Every entry indicates a
publication date. If a manual is revised and reposted, the date will change. Since we post
revised manuals on a regular basis, you should check this site for updates.
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Package Version History

The following table provides a list of enhancements since Version 1.00.

Version

Release Date

Enhancements

1.00

May 2006

6 reports; Database Oracle SPI Datapipe 1.00

1.10

April 2007

Location Independent Reporting (LIR)
Database Oracle SPI Datapipe 1.10
UPGRADE _Database_to_11
UPGRADE_Database_Oracle_to_11
defect fixes:

e QXCR1000351048

e QXCR1000351071

e QXCR1000367499

e QXCR1000368580

e QXCR1000386279

e QXCR1000386567

1.10

October 2007

Database Oracle SPI Datapipe 1.20
defect fixes:

e QXCR1000427865 - Map procedure failed, cannot
insert NULL into DSI_DPIPE.SRDBINST_SEGMENT

e QXCM1000415912 - Oracle Database Report Pack not
showing all the reports

1.20

February 2008

Copy Policy Enhancement
UPGRADE_Database_to_12.ap
UPGRADE_Database_Oracle_to_12.ap

1.20

February 2009

’ The upgrade packages dated February 2008 are not available on CD-ROM. Both must be
downloaded. The next chapter of this guide contains several references to a report pack CD
containing installable packages. Since there is no CD, you may ignore those references. If you
need help downloading or installing the two upgrade packages released February 2008, refer
to release notes.

Overview
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2 Upgrading the Report Pack

This chapter covers the following topics:
e  Guidelines for a Smooth Upgrade

e Upgrading to Version 1.20

e Package Removal

If you are installing the Database Report Pack for the first time, this chapter does not apply to
you. See Chapter 3, Installing the Report Pack.

Guidelines for a Smooth Upgrade

When you insert the report pack CD in the CD-ROM drive and launch the package extraction
program, the install script extracts every package from the CD and copies the results to the
Packages directory on your system. When the extract finishes, the install script prompts you
to launch Performance Insight and start Package Manager. Before running Package Manager,
review the following guidelines:

e Prerequisites for the Database Report Pack
e Datapipes and Remote Pollers

e (Custom Table Views

e Upgrading Common Property Tables

e Upgrading Database in a Distributed Environment

Prerequisites for the Database Report Pack

Make sure the following software is installed before upgrading to Database 1.20:
¢ Performance Insight 5.40
e All service packs available for Performance Insight 5.40

e Common Property Tables 3.90

Datapipes and Remote Pollers

If you uninstall an existing datapipe, the following information is lost:
e Single polling policy for a remote poller
¢ Cloned polling policies for multiple remote pollers

¢ (Customized polling groups
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To prevent this information from being lost, you can use the following commands to export
existing polling policy configurations and customized polling groups:

e collection_manager

® group_manager

Exporting Polling Policy Configurations
If your environment contains polling policies for remote pollers, use the collection_manager
command to export existing policy configurations to a file.
UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME
Jbin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the PI install directory
and run the following command:

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to
export groups to individual .xml files.

UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME
Jbin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the PI install
directory and run the following command:

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you are using table views you created yourself, the views you created may interfere with the
report pack upgrade, causing the upgrade to fail. Whether or not your views interfere with the
upgrade process depends on how you created them. If you used SQL to create them, the
upgrade will succeed, however, your custom views will not be available once the upgrade is
complete. If you used Datapipe Manager to create them, the upgrade is likely to fail. To
prevent the upgrade from failing, delete custom table views before you upgrade the report
pack, then recreate those views after the report pack is upgraded.

Upgrading Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade that
package to version 3.90 or higher. If you are not running any version of Common Property
Tables, Package Manager will install the latest version of Common Property Tables for you,
automatically.

Do not install an upgrade for Common Property Tables and other packages at the same time.
Install the upgrade package for Common Property Tables and only the upgrade package for
Common Property Tables. For more information about installing and using Common Property
Tables, refer to the Common Property Tables User Guide.
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Upgrading Database in a Distributed Environment

Following is an overview of the installation procedure for a distributed environment:

1
2

4
5

Disable trendcopy on the central server.

For the central server:

e Upgrade to Common Property Tables 3.90; deploy reports

e Upgrade to Database 1.20 (including any sub-packages); deploy reports
For each satellite server:

e Upgrade to Common Property Tables 3.90 or higher

e Upgrade to Database 1.20 (including any sub-packages)

e Remove Database Oracle SPI Datapipe 1.10

e Install Database Oracle SPI Datapipe 1.20

Re-enable trendcopy on the central server.

Reconfigure your central and satellite servers.

When Database 1.00 was installed, the person who installed that version had to set up
connections with satellite server databases, configure trendcopy commands, and switch off
aggregations above the hourly level at each satellite server. If you just upgraded to
Performance Insight 5.40, server configuration changes that were made when Database 1.20
was installed must be redone. For details, see Chapter 4, Setting Up a Distributed System.

Upgrading to Version 1.20

Perform the following tasks to upgrade from any earlier version to version 1.20:

Task 1: Stop OVPI Timer and extract packages from the report pack CD
Task 2: Upgrade to Common Property Tables 3.90

Task 3: Install the Upgrade Packages

Task 4: Remove Database Oracle SPI Datapipe 1.10

Task 5: Install Database Oracle SPI Datapipe 1.20

Task 6: Restart OVPI Timer

Task 1:  Stop OVPI Timer and extract packages from the report pack CD

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:

a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.

¢ From the Action menu, select Stop.

Upgrading the Report Pack 2]
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Task 2:

Task 3:

On UNIX, as root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens
automatically; on UNIX, mount the CD if the CD does not mount automatically, navigate
to the top level directory on the CD, and run the . /setup command.

Type 1 in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following folders
under the Database folder:

Database.ap

Database_Threshold.ap
Database_Oracle.ap
Database_Sr_Integration.ap
Database_Demo.ap
UPGRADE_Database_to_12.ap
UPGRADE_Database_Oracle_to_12.ap

Upgrade to Common Property Tables 3.90

Follow these rules:

Do not install any other package with the Common Property Tables upgrade package;
install the Common Property Tables upgrade package and only the Common Property
Tables upgrade package.

When prompted to accept or disable the option to Deploy Reports, accept the default. If
you do not deploy reports, you will not deploy the change forms that come with Common
Property Tables.

When the install finishes, click Done to return to the Management Console.

Install the Upgrade Packages

1

From the Management Console, select Tools > Package Manager. The Package Manager
welcome window opens.

Click Next. The Package Location window opens.
Click Install.

Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports,
Application Server, and Port. Type your user name and password for the PI Application
Server.

Click Next. The Package Selection window opens.

Click the check box next to the following packages (depending on which packages you are
upgrading):

UPGRADE_Database_to_12.ap
UPGRADE_Database_Oracle_to_12.ap
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7  Click Next. The Type Discovery window opens. Disable the default.
8 Click Next. The Selection Summary window opens

9  Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

10 Click Done.

) Do not be surprised if the UPGRADE package you just installed disappears
from view. Package Manager will display what you just installed as Database
Report Pack 1.20. This is not an error.

Task 4:  Remove Database Oracle SPI Datapipe 1.10

The Database Oracle SPI Datapipe cannot be upgraded. You must remove Database Oracle
SPI Datapipe 1.10. Start Package Manager and follow the on-screen instructions for package
removal. When Package Manager tells you that removal is complete, click Done to return to
the Management Console.

) It is possible that you are already running the latest datapipe, version 1.20. If you are, ignore
this task.

Task 5:  Install Database Oracle SPI Datapipe 1.20

1 Start Package Manager. The Package Manager welcome window opens.

2  Click Next. The Package Location window opens.
3 Click Install.
4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports.
5 Click Next. The Package Selection window opens.
6  Click the check box next to the following package:
Database Oracle SPI Datapipe 1.2
7  Click Next. The Type Discovery window opens.

8 Click Next. The Selection Summary window opens.

9  Click Install. The Installation Progress window opens and the install begins. When the
install finishes, the package installation complete message appears.

10 Click Done.

Task 6:  Restart OVPI Timer
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX: As root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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Package Removall

Follow these steps to uninstall the Database Reporting Report Pack:

1

N OO0 O AN

10

1
12
13

14
15

Log in to the system. On UNIX systems, log in as trendadm.

Stop OVPI Timer and wait for processes to terminate.

Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.

Click the Uninstall radio button.

Click Next. The Report Undeployment window opens.

If reports were deployed to the PI Application Server, accept the defaults for Undeploy
Reports, Application Server Name, and Port. Otherwise, clear the check box and skip to
step 9.

Type your username and password for the PI Application Server.
Click Next. The Package Selection window opens.
Click the check box next to the following packages:
Database 1.2
Database Demo 1.2
Click OK.
Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal process begins. When the
uninstall process is complete, a package removal complete message appears.

Click Done to return to the Management Console.
Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start
Sun: sh /etc/init.d/ovpi_timer start
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3 Installing the Report Pack

This chapter covers the following topics:
¢ Guidelines for a Smooth Install

e Installing the Database Report Pack
e Accessing Deployed Reports

e Package Removal

Guidelines for a Smooth Install

An PI reporting solution has two ingredients, a report pack and a datapipe. Some reporting
solutions include multiple datapipes. When you install the datapipe, you configure PI to
collect a specific type of data at a specific interval. When you install the report pack, you
configure PI to summarize and aggregate performance data in accordance with specific
processing directives issued by the report pack.

The report pack CD includes the latest report packs, datapipes, and shared packages. When
you insert the CD in the CD-ROM drive and launch the package extraction program, the
install script copies every package from the CD to the Packages directory on your system.
After the extract finishes, the install script prompts you to start Package Manager. Before
using Package Manager, review the following guidelines.

Software Prerequisites

Version 1.20 of the Database Reporting Report Pack has the following prerequisites:
¢ Performance Insight 5.40
e All service packs available for Performance Insight 5.40
e Common Property Tables 3.90
e SysRes OVPA Collection Datapipe 1.10
e HP Operations/OM Management Server, version 7.20 or later
e Database Oracle Smart Plug-In (SPI):
— Version B.09.01 for Windows
— Version A.09.10 for UNIX

If you are not currently running any version of Common Property Tables, let Package
Manager install version 3.90 for you. If you are running an earlier version of Common Property
Tables, upgrade to version 3.90. Upgrading Common Property Tables is easy; however, if you
need assistance with the upgrade, or if you want to know more about how this package
operates, refer to the Common Property Tables User Guide.
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Distributed Environments

If you intend to run Database Reporting in a distributed environment, installation is more
complicated, since you must install the report pack multiple times, once on the central server,
and once on each satellite server. Typically, you will not install the datapipe on the central
server, since the central server is not polling. Where you install the thresholds sub-package
depends on how you want to implement thresholding.

Here is an overview of package installation in a distributed environment.
1 Make sure that every server is running PI 5.40.
2 Make sure that every server is running all available service packs for PI 5.40.
3 Disable trendcopy on the central server.
4 Install the following packages on the central server:
e Common Property Tables 3.90
e SysRes OVPA Collection Datapipe 1.10
e Database Report Pack
e Oracle sub-package
e Thresholds sub-package
5 Install the following packages on each satellite server:
e Common Property Tables 3.90
e SysRes OVPA Collection Datapipe 1.10
e Database Report Pack
e Oracle sub-package
e Thresholds sub-package
e Database Oracle SPI Datapipe 1.30
6 Re-enable trendcopy on the central server.

If you do not want local reporting (viewing reports on satellite servers), there is no need to
deploy reports to the PI Application Server when you install packages on satellite servers.
However, if you want local reporting, be sure to deploy reports (and forms) when you install
packages on a satellite server.

When you finish installing packages, you have to set up a distributed system. This involves
setting up connections with satellite server databases, configuring the central server to copy
data from satellite servers, and switching off higher-level aggregations at the satellite servers.
These steps are covered in Chapter 4, Setting Up a Distributed System.

Installing the Database Report Pack

Perform the following tasks to install Database Reporting on a stand-alone system:
e Task 1: Stop OVPI Timer and extract report packs from the report pack CD

e Task 2: If necessary, upgrade to Common Property Tables 3.90

e Task 3: Install the report pack and the Database Oracle SPI Datapipe
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Task 1:  Stop OVPI Timer and extract Pl packages from the CD
1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.
Windows: Select Control Panel > Administrative Tools > Services
UNIX: As root, do one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop
3 Insert the report pack CD in the CD-ROM drive. Do one of the following:

e  Windows: run the setup.bat command if auto run is disabled. If auto run is enabled,
a Main Menu appears.

e UNIX: mount the CD manually if the CD does not mount automatically, then run the
setup command.

4 Type 1 to select PI report packs in the choice field and press Enter. The install script
displays a percentage complete bar. When extraction is complete, the install script starts
Package Manager. The Package Manager Welcome window opens.

) If you navigate to the Packages directory on your system, you will see
the following folders under the Database folder:

e Database.ap

e Database_Threshold.ap

e Database_Oracle.ap

e Database_Sr_Integration.ap

e Database_Demo.ap

e UPGRADE_Database_to_12.ap

e UPGRADE_Database_Oracle_to_12.ap

You may ignore the upgrade packages. Installing the demo package is
optional. You may install the demo package by itself, or you may
install the demo package along with the report pack.

Task 2:  Upgrade Common Property Tables

If you are running an older version of Common Property Tables, upgrade to Common Property
Tables 3.90. Do not install the upgrade for Common Property Tables and other packages at the
same time. Install the upgrade package for Common Property Tables and only the upgrade
package for Common Property Tables. When Package Manager indicates that the installation
is complete, click Done to exit Package Manager and return to the Management Console.

Task 3:  Installing Database Reporting

1 Start Package Manager. The Package Manager welcome window opens.
2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select
a different directory, if necessary.

4 Click Next. The Report Deployment window opens. Accept the default settings for Deploy
Reports; also accept the defaults for application server name and port in the same window.

5 Enter your username and password for the PI Application Server.
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6  Click Next. The Package Selection window opens.
7  Select the check box next to the following packages:
Common Property Tables 3.9
SysRes OVPA Collection Datapipe 1.1
Database Report Pack 1.2
Database Oracle 1.2 sub-package
Database Oracle SPI Datapipe 1.3
Database Report Pack Demo
8 Click Next. The Type Discovery window opens.

9 To run Type Discovery immediately after package installation, keep the default and click
Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When
the install process is complete, an installation complete message appears.

11 Click Done.
12 Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed the report pack, you enabled the Deploy Reports option. As a result, the
reports in this package (as well as the thresholds form) were deployed to the PI Application
Server. Once the reports reside on the PI Application Server, you have two ways to view them:

e PI client applications
e  Web browser

If you have the client applications, you have access to Report Viewer, Report Builder, and the
Management Console. If you do not have the client applications, using a web browser to view
reports is the only way you can view reports. For more information about the clients, refer to
the PI Installation Guide. For details about the Management Console, including how to use
the Object/Property Management view to launch reports specific to a selected object, refer to
the PI Administration Guide.
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Package Removall

Follow these steps to uninstall the Database Reporting Report Pack:
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Log in to the system. On UNIX systems, log in as trendadm.

Stop OVPI Timer and wait for processes to terminate.

Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.

Click the Uninstall radio button.

Click Next. The Report Undeployment window opens.

If reports were deployed to the PI Application Server, accept the defaults for Undeploy
Reports, Application Server Name, and Port. Otherwise, clear the check box and skip to
step 9.

Type your username and password for the PI Application Server.
Click Next. The Package Selection window opens.
Click the check box next to the following packages:
Database 1.2
Database Demo 1.2
Click OK.
Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal process begins. When the
uninstall process is complete, a package removal complete message appears.

Click Done to return to the Management Console.
Restart OVPI Timer.
Windows: Select Settings > Control Panel > Administrative Tools > Services.
UNIX: As root, type one of the following:
HP-UX: sh /sbin/init.d/ovpi_timer start
Sun: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System

Follow these steps when setting up a distributed system:
1 Decide whether you want local reporting or central reporting.

2 Install the right set of packages on each server (a central server that is not polling will not
need datapipes; every satellite servers will need datapipes).

Verify that the system clocks in your environment are synchronized.

Register your satellite servers.

If you are not copying rate data to the central server, enable LIR on the central server.
If you enable LIR, add LIR mapping with the time type set to rate.

Verify that you have all the copy policies you need.

Configure the central server (manual edits to trendtimer.sched and .pro files).
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Configure each satellite server (manual edits to trendtimer.sched and .pro files).

If you want local reporting, you need to deploy reports when you install the report pack on
each satellite server, and you also need to allow summarizations to run on each satellite
server. If you do not want local reporting, then you do not need to deploy reports when you
install a report pack on a satellite server, and you can disable the scripts that run
summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone
setting up a distributed system was to deploy reports on satellite servers, keep rate data on
satellite servers, copy hourly data to the central server, and disable summarizations above the
hourly level on satellite servers. This approach had two benefits. It kept a lot of rate data off
the network, and it decreased the processing load on the central server. The problem with this
approach is that the central server could not display a Near Real Time (NRT) report. The only
NRT report was a local NRT report, on a satellite server.

LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server
and drill-down on table selections. The selections you make cause the central server to query a
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the
central server, you can. If you do, then enabling LIR is not necessary.

The Database Report Pack comes with a copy policy import file. When you install the report
pact, PI uses this file to generate copy policies. Creating these policies yourself, using the
Management Console, is no longer necessary. Your only task is to verify that you have the
copy policies you need.

Because you are likely to have multiple satellite servers, we designed the hourly process files
to be satellite-server friendly. This means that most of the time, most of the defaults are
correct. But some defaults will be incorrect, or less than optimal, and to improve performance,
you should change them. These manual edits, as well as the other steps listed above, are
spelled out in detail in this chapter.
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Configuring the Central Server

Task 1:

Task 2:

Task 3:

To configure the central server, perform the following tasks:

e Task 1: Register the satellite server by setting the database role

e Task 2: If you are not copying rate data from satellites to the central server, enable LIR
e Task 3: If you enable LIR, add LIR mappings

e Task 4: Verify the automatically generated copy policies

e Task 5: Delete LIR mappings for rate tables

e Task 6: Modify the trendtimer. sched file

e Task 7: Modify the Database Hourly.pro file

Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the database system.
Click Database Properties.

From the Database Role list, select the Satellite Server role.
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Enter any information necessary to configure the Satellite Server role.

To add a new database reference, you can use the Add Database Reference Wizard in the
System and Network Administration application.

Enable LIR

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.
Click LIR Configuration.
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Select the LIR enabled check box.

Add LIR mappings

Configure LIR mappings for the following categories (for the database and Oracle
sub-package you have installed): Database and Database_Oracle.

1 Start the Management Console (log on with Administrator privileges).

Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Click Add Mapping.

From the Select Satellite Server list, select a satellite server to which to add a mapping.

Select the Category data table option.
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Select Database from the drop down list.
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9 Select the rate data type.
10 Click Add to List.

N If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through
step 10.

12 Click OK.
13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that
you add. The data type selected when adding an LIR mapping (in step 9 above) determines
the type of data copied that is defined in the generated copy policy (the type of data copied
that is defined in the generated copy policy is for one greater than the data type selected in
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is
generated.

Task 4:  Verity that copy policies were generated automatically

Verify that a copy policy has been generated for the following tables and that the copy type is
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).
2  Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the following tables (for the database and sub-package you have installed) and verify
the copy type is set to Property and Data for each table:

Database Oracle Sub-package
SHDBINSTANCE SHDBINST_SEGMENTS
SRDBINSTANCE SHDBINST TBLSPACES

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy
Manager. The Copy Policy Wizard displays.

Click Next. The Satellite Server and Copy Policy Selection Page displays.

w

Select a satellite server from the pull down list. This is the satellite server from which
data is copied to the central server.

Select Single Table and select the table from the pull down list.
Click Next. The Copy Type Selection Page displays.

Select Property and Data.

Click Next. The Summary page displays.
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Verify the information in the summary window. If the information is not correct, you can
modify it by clicking Back.

9  Click Finish.

10 Repeat step 4 - step 9 for all missing tables.

If the copy type is not set to Property and Data, do the following:
1 Double-click the copy policy.

2 Select the Property and Data copy type.
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Task 5:

Task 6:

Task 7:

3 Click OK.

Delete LIR Mappings for the SRDBINSTANCE rate table
Delete the LIR mappings for SRDBINSTANCE (the data is being copied to the central server).

1 Start the Management Console (log on with Administrator privileges).
Click the Systems icon in the navigation pane.

Navigate to the OVPI Databases folder and select the central server.

Click LIR Configuration.

Unselect the Rate check box for K DBINSTANCE and KV_DBINSTANCE.
Click Apply.
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Modify the trendtimer.sched file

The trendtimer. sched file is found in the {DPIPE HOME}/1ib/ directory where
{DPIPE HOME} is the directory in which PI is installed.

If you installed the Oracle sub-package, make the following change to this file:
¢ Find and comment out the following line:

1:00+30 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE HOME}/scripts/Database Oracle Hourly.pro

Modify the Database_Hourly.pro file

The Database Hourly.pro file is found in the {DPITPE HOME}/scripts/ directory where
{DPIPE HOME} is the directory in which PI is installed.

Make the following change to this file:
e  Comment out the DB_1 block section.
e  Comment out the DB_2 block section.

Configuring a Satellite Server

Follow these steps to configure a satellite server.
1 Disable aggregations at the daily level and above.

a Openthe {DPIPE HOME}/lib/trendtimer.sched file (where {DPIPE HOME} is
the directory in which PI is installed)

b Find and comment out the following lines:

24:0043:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE_HOME}/scripts/Database DMF.pro

24:0043:00 - - {DPIPE HOME}/bin/trend proc -f
{DPIPE_HOME}/scripts/Database Oracle DMF.pro

2 Modify the {DPIPE HOME}/scripts/Database Hourly.pro file (where
{DPIPE HOME} is the directory in which PI is installed):
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e Comment out the DB_3 block, including the begin and end lines.

3 Ifyou installed the Oracle sub-package, modify the {DPTPE HOME}/scripts/
Database Oracle Hourly.pro file:

¢  Uncomment the DB_1 block, including the begin and end lines.

System Clocks

Verify that the system clock on each satellite server is synchronized with the system clock on
the central server.
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5 Generic History Reports

There are two generic history reports in Database Reporting:
1 Instance Size History

2 Instance Size Details Top 20

Instance Size History

This report looks at dynamic space usage over the previous week, and allows you to spot
instances with the highest dynamic space usage. The building block in this report is a daily
average for instance-size-used and a daily average for instance-size-free. The daily averages
are rolled up, producing averages for the week that appear in the top selection table.

The top selection table sorts instances by dynamic space usage, most to least. The data in the
usage details table below the selection table shows the daily fluctuation in average
instance-size-free vs. average instance-size-used. The tabbed graph below the usage details
table displays a daily bar chart and a monthly bar chart. Both charts show the fluctuation in
free vs. used, allowing you to see historic trends.

Instance Size Details Top 20

This report reveals which database instances are using the most instance size. It measures
instance size three ways:

e As a percentage
e In megabytes
¢ In megabytes allocated

Each selection table on the left looks at yesterday’s data. Each graph to the right shows what
the trend has been over the previous 7 days.
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Database Report Pack

Instance Size History Report

O

invent

Thiz report shovws top 20 instances which had the most dynamic space usage over the previous week. The instances were selected
uzing the standard deviation of the amount of space uzed. The graph showy histarical trends far the space usage on daily and morithly

basziz.
Top 20 Instance
Sorted Based On Most Dynamic Space Usage (MB)
Man, Mar 28, 2005 - Man, Mar 28, 2005
. Instance Average
Instance Size g i
System Hame  Instance Mame Yendor [hmamic Size  Instance Size
Allocated
Usage Free
ovpintd Owpintsd Oracle 1024 .00 F0.a0 22085
'cq,] ovpihpts Cwpibpts Qracle 1024.00 3559 00,02
Customer Name Location Name
Customer Unazsigned Location Unassigned
Instance Size Usage Details
Tue, Mar 29, 2005 - Sat, Apr 2, 2004
Date Instance Size Mlocated Average Instance 5ize Average Instance 5ize
Used Free
Tue, Mar 29 12:00 &AM 1024.00 444 59 57941
Wed, har 30 1200 &bk 1024 .00 B16.23 407 77
Thu, har 31 12:00 26 1024.00 49370 530.30
Fri, &pr 1 12:00 A 1024.00 54797 47603
Sat, Apr 2 12:00 A6 1024.00 42099 603.01

Chapter 5



Diaily anthly
AU‘EI’&QE Instance Size USEQE Trend [ME:I
Tue, Mar 29, 2005 - Sun, Apr 3, 2005
2000007

o1 E00.00T

Z

81200007

L1}

2 g00.00

m

E

— 400.00

I:I.
fu] ] - - ™ o]
™ ] ] (=] fm] o
m m m & & &
= = = I <L <L
.ﬁmerage Instance Size Free
.ﬁmerage Instance Size Used
@ Back to Top =
Generic History Reports

39

et



40

Database Report Pack
Instance Size Details Top 20 Report

This report showes top 20 Instances sorted based on megabytes allocated, megabytes used and percentage used with one table and a con

category.

Top 20 Instances
Sorted Based on Average % Used
Sun, Apr 3, 2005 - Sun, Apr 3, 2005
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Hame Hame Size Size Free =
Allocated Used (%) o @
= GooaT
ovpihpts  Ovpibpt3  Cracle 1024 00 53.35 46 B5 K
L ovpintd  Ovpints4  Oracle 1024 00 4532 51 63 ' anoot
T
£ 0007
u] + + {
o [} -— -
] [} [} 4
m m m |
= = = :
Porerage Instance Size Usage [
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Top 20 Instances
Sorted Based on MegaBytes Allocated
Sun, Apr 3, 2005 - Sun, Apr 3, 20045
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6 Generic NRT Reports

There are three generic NRT reports in the Database Report Pack:
1 Instance Availability in Near Real Time
2 Number of Transactions in Near Real Time

3 Number of logons in Near Real Time

Availability NRT
Contains one selection table and one tabbed graph. The selection table looks at actual sample
data collected over the previous six hours, not hourly averages. The selection table shows:
e Total Instance Uptime in minutes
e Total Instance Downtime in minutes
e Total Instance Unknowntime in minutes

The selection table sorts instances by Total Instance Uptime, most to least. Use the graph
below the selection table to see trending on an hourly, daily, and monthly basis.

Logons NRT
Contains one selection table and one tabbed graph. The selection table looks at actual sample
data collected over the previous six hours, not hourly averages. The selection table shows:
e Total logons
e Maximum logons (per hour)
e  Minimum logons (per hour)
e Average logons (per hour)

The selection table sorts instances by Total Instance Uptime, most to least. Use the tabbed
graph below the selection table to see trending on an hourly, daily, and monthly basis.

Transactions NRT
Contains one selection table and one tabbed graph. The selection table looks at actual sample
data collected over the previous six hours, not hourly averages. The selection table shows:
e Total transactions
e Maximum transactions (per hour)
e Minimum transactions (per hour)
e Average transactions (per hour)

The selection table sorts instances by Total Instance Uptime, most to least. Use the tabbed
graph below the selection table to see trending on an hourly, daily, and monthly basis.
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Instance Availability Near Real Time Report

invent

Thiz report showws databaze instances sarted based on total uptime minutes of the instance. The report alzo shoves total downtime

and total unknowven titme for each instance. In addition it displays hourly | daily and monthly trends for wptime, dowertitne and unknowvwn
time. The daily and mornthly trends are interms of percentages.
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Instance Logons Near Real Time Report

invent

Thiz report showes the number of uzer logons per instance over a period of last 6 hours. Selecting an instance from the top table gives
the logon trend over the for hourly, daily and manthly .

Logon Details Per Instance For Previous 6 Hours

System Name  Instance Yendor Total Logons Maximum Minimurm Average
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Instance Transactions Near Real Time Report

invent

Thiz report shows the number of transaction per instance over a period of last 6 hours . Selecting an instance from the top table gives
the transaction hourly, daily and morthly trend.

Transaction Details Per Instance for Previous 6 Hours

System Total Maximum Minimum Average
Instance Yendor i . . !
Hame Transactions Transactions Transactions Transactions
ovpintd OvypintSd Oracle 424 B3 96,16 39.81 T0.77
ij] ovpihptd Cvpibpt3 Oracle 32980 95 53 386 54492
Customer Hame Location Hame
Customer Unassigned Location Unassigned

oy | o | oy |

Average Transaction Trend
Maon, Apr 4 3:00 PM - Mon, Apr 4 7:00 PM
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/ Aggregation Reports

There are two aggregations reports in the Database Report Pack:

¢ Customer Summary Report
e Location Summary Report

See below for samples of each.

will be shown in three tables on the right.First table will prowide last 2 hrs

data. zecond one provide last day summarized data for one customer. Third
Customer Summary Report y '

ane provide monthly summarized data forselectad customer.

Thiz reportwill give information about a CustomerHere uzer can selact any
Data base Re port PaCk customer from left panel and all aggregated information about that custamer (ﬁﬁ]

invent

CUSTOMER NAME Customer Usage Details For Last 2 Hrs

. Total Up Time Total Down Time Time Period
Customer Unassigned

7500 0.00 tdan, Apr 11 1000 A

Custorer Usage Details For Last Day

Percentage Average Down  Average Instance Average Instance Average Instance
Instance Uptime Time Size Free Logons Size % Used
100.00 0.00 £34.10 10.00 60.58

Custorner Usage Details For Last Month

Percentage Average Down  Average Instance Average Instance Average Instance
Instance Uptime Time Size Free Logons Size W Used
5014 0.o0 507 B4 45499 50.43

W\/\/\/\/\/\/\/
iy [ ey | oy |

Hourly Instance Uptime Details For Custorer
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This report will give information about a Location. Here user can select any
Database Report Pack

Location fram left panel and all aggregated information about that Location
will be shown in three tables on the right.First table will provide last 2 hrs

- data. second one provide last day summarized data for ane customer. Third
Location Summary Report

ane provide monthly summarized data forzelected Location.

i

invent
LOCATION NAME ] Location Uzage Details F-chr Last 2 Hrs ] i
Location U e Total UpTime Total Down Time Time Period
SISE R NS ENE 75.00 0.00 Man, &er 11 10:00 &b

Location Usage Deatils For Last D=y

Percentage Average Down Average Size Average Average Size

Location Usage Details For Last Month

Instance Time Free Logons % Used Time Period
Uptime
100.00 0.0o0 59410 10.00

60.55 Sun, Apr 10 12:00 A

Percentage Average Down . Average Size %
Instance Uptime Time Average Size Free Average Logons Used
2014 0.o0 507 B4 45499 50.43

camen

Hourly Instance Uptime Detsils For Location
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8 Selector & QuickView

See below for samples of:
¢ Adhoc Instance Selector

¢ Instance QuickView

Thiz report allows wou ta filter the entire databaze instance set by several common
Data base Re port PaCk criteria. The table below will then refresh showing vou which instance comphy b
wiith the drop down selections. If you are accessing the report fram the web ﬁ

interface wou can then cross launch many other reports with infarmation relating to

Adhoc Instance Selector the selected instance. inven:t
Choose System ~ |Chnuse Customer j Choose Yendor =
Choose Instance ~ |Chnuse Location j
Instance Details
Mon, Apr 25 12:00 AM [GMT+05:30]
em Average Average Average ::1\;1&;:?:2
EN!":m[ o Instance Vendor Customer Location Instance Instance Instance Percentage
Uptime Logons Transactions N o
Size Used
ovpibpt3 Orvpibpt 3 Oracle Cuzstomer Unassigned Locstion Unassigned 245 53.35
ovpintd OrvpirtSd Oracle Cuzstomer Unassigned Locstion Unassigned 240 48 .32
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Database Report Pack

Instance Quickview Report

Thiz report gives as quick graphical overview of 6
database instances providing such details as F
logons, transactions, instance size usage and

auailability. inwvent

System Name

ovpintd =

Instance Availability NRT Details
Sun, Apr 3 8:00 PM - Mon, Apr 4 7:00 PM

=
=
=
=

Instance availabilityhins)
oW b
e
o o o o
S o o o

Sun 20:00

Mon, Apr 4 3:00 PM - Mon, Apr 4 7:00 PM
Qo.0a -

0w i ~4
- P iy
=1 f=1 =
=1 =1 =1

12.007T

Average NMumber Of Logons

o
F1
F ]
F ]

Customer

Customer Unassigned

[u]
Ju]

o
o

Sun 23:00
hlon 02
fon 050
hlon 083
fdan 11:00

|:|T-:|t.al Instance Uptime
.Tnt.al Instance Crowntime
.TDTInEUnknuwnTime

ao

hlon 14

Average Logon Trend

Yendor

Oracle =

[u]

Mon 17:0

_{

Aorerage NMumber Of Transactions

E

Mon 1500

50

fdon 15230
hdon 1600
hon 1620
tdon A7 00
fdon A7 220

Awerage Instance Logaons & Hales

Mon 1200

Man 158:30

tan 1900

Instance Name

Owpintsd '|

Location 2
Location Unassigned

Instance Size Usage Trend{MB)
Tue, Mar 29, 2005 - Sun, Apr 3, 2005

200071
1,600 7

1,200 1

-ARAREE

Dﬂverage Instance Size Used
.A'Lrerage Instance Size Free

Instance Size Used

Tue Mar29
red Mar20
Thu hiar =1
Fri Apri
Sat Aprz
Sun Aprd

Average Transaction Trend
Sun, Apr 3 8:00 PM - Mon, Apr 4 7:00 PM

1000071
a0.00 1
G0.00 T
40.00 7

200071

Sun 20:00
Sun 2300
hdon OZ:00
hdon 0500
hdon 000
fdon 1100
hdon 1400
hdon 1700

—Auwerage Instance Tranzactions & Hales
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9 Oracle Segment Reports

There are two segment reports in the Database Report Pack:

e Segment Size History
e Segment Size Details

See below for samples of each.
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Database Report Pack f
Segment Size History Report (ﬂ

invent

Thiz report shows the top segments which had the most dynamic space allocation over the reparting interval The top segments were
zelected using the standard deviation of the amount of space allocated. The graph alzo shows historical trends for the size allocsted
oh daily and morthly basis,
Top 20 Segments
Sorted Based On Most Dynamic Space Allocation
Mon, Mar 28, 20045 - Maon, Mar 28, 2004
Average Size  Dynamic Size

System Hame Instance Vendor Segment HMame Allocated Allocation
avpintd Cvpiritsd Cracle EXAMPLE SH.COSTS 53049 79.53
-qa avpihpt3 Cvpibipt 3 Cracle EXAMPLE SH.PRODUCTS 453.86 5789
'qq avpirtd CrpirtSd Cracle SNETEM.SYS | _SOURCE 07 .21 5580
=L ovpinpt3 Cvpibpt3 Oracle SYSTEM.S¥S) 0BJ2 536 41 5279
Customer Hame Location Hame
Customer Unaszigned Location Unassigned

Segment Size Allocation Details
Tue, Mar 28, 2005 - Sat, Apr 2, 2004

Time Period Average Segment Size Allocated
Tue, Mar 29 12:00 &AM 436.45
Wed, Mar 30 12:00 AM B23.75
Thu, Mar 31 12:00 A 504.05
Fri, &pr 1 12:00 Ak 625.035
Sat, Apr 2 12:00 Ak 528.75
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Database Report Pack
Segment Size Details Report

iy

invent

Thiz report showes the top 20 segments sorted by megabytes allocated. Selecting a segment from the top table gives the daily and
motthly uzage trends for the segment.

Top 20 Segments
Sorted Based on Total Allocated Size (MB)
Sun, Apr 3, 2005 - Sun, Apr 3, 2005

Systemn Hame Instance Name Yendor Segment Hame Total ASIEJ!:::;“; Size
ovpihpt3 Crypihipt3 Oracle SYETEM.SYS_OBJZ 14670.99
ﬂ avpibpt3 Crepibpt Oracle EXAMPLE.SH PRODUCTS 1254587
“ ovpintd CrpintSd Oracle SYETEM.EYSI_SOURCET 1184032
ﬂ avpintd Crepairtd Oracle EXAMPLE.SH.COSTS 113 27
Customer Hame Location Hame
Customer Unassigned Location Unassigned

Drily ]( hordhly W

Segment Size Details (MB)
Tue, Mar 29, 2005 - Sun, Apr 3, 2005

20000007
18,000.00 T

16,000.00 T

14,000.00 1
12000001
10,000.00 1

5,000.00T

G,000.00 1

Segment Size Allocated (MB)

4,000.00 1

2000007

o

hlar 29
hiar 30
hiar 31
Apr o1
Apr 02
Apr03

O 7otal Segment Size Allocated
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10 Oracle Tablespace Reports

There are five tablespace reports in the Database Report Pack:

e Tablespace Physical I/O Top 20

e Tablespace Size History

e Tablespace Size Allocated Top 20

e Tablespace Size Used Top 20

e Tablespace Size Percentage Used Top 20
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Database Report Pack
Tablespace Physical IO Top 20 Report

[/

invent

Thiz report showws the top 20 takblespace by phyzical BO (reads plus writes) for the previous week. Selecting a tablespace from the
top takle, shows the daily and manthly 10O trends for the tablespace.

244

System
Hame

ovpirtd
ovpintd
ovpibpt3
ovpintd
owvpihpt3
ovpintd

Draily hdarithly

Top 20 Tablespaces
Sorted Based On Total Physical 10
Sun, Apr 1Y, 2005 - Sun, Apr 24, 2005 [GMT+05:30]

Instance Vendor Tablespace thal Max?mum I'u'Iini_mum n'q.-'e_rage

Hame Hame Physical I0 Physical 10 Physical 10 Physical 10
Owpirtsd Oracle DRSYS TE2ET3.54 9961 55 109964 SF7T.78
Owpintsd oracle CWHLITE 726634 .75 9915.13 1229.29 45705.92
Ovpibiprt3 Oracle EXAMPLE 73782359 995293 122510 5532.06
OwpintSd Oracle SYSTEM 7334141 9592595 115364 S640.42
Crepibiprt3 Oracle xoB 72407033 9971 .07 1107 64 5424 47
Owpintsd Oracle SERS F053221 .52 9696 .91 1037 BB 527953

10,000.00 T
9.000.00 T

4.000.00 T
3.000.00 T
2000001

Tablespace Physical [0

1,000.00 1

0

5,000.00 T
F.000.00 1
G,000.00 T
5.000.00 T

Tablespace Physical 10 Trend
Tue, Mar 29, 2005 - Sat, Apr 2, 2005

har 29
hiar 20

.ﬁ-.xrer.age Tablespace Fhysical 10
B b4 i mum Tablespace Physical 10
M tinimum Tablespace Physical 10

hdar 31
Aprod

Aprioz
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Database Report Pack
Tablespace Size History Report

O

invent

Thiz report shows the top tahlespaces which had the most dynamic space usage over the reporting interval The top tablezpaces were
zelected using the standard deviation of the amount of space uszed. The graph alzo shows historical trends for the zize usage on daily

ahd morthly basis.

Top 20 Tablespaces
Sorted Based On Most Dynamic Space Usage
man, Mar 28, 2005 - Maon, Mar 28, 2005

System Instance Vendor Tablespace Average Size Dynamic  Average Size
Mame Hame Hame Allocated Space Usage Free
ovpihipt3 O pibpts Oracle hiNS] 1024.00 496 .55
'CE] ovpintd Crvpintsd Qracle USERS 1024.00 ¥1.92 457 .72
'qﬁ] ovpintd Crvpintsd Oracle SYSTEM 1024.00 ¥1.54 521.35
'CE] ovpihpt3 Crpibpt 3 Oracle EX&MPLE 102400 G2.41 07 92
'CE] ovpintd Crvpintsd Oracle DREYS 1024.00 s0.02 535.00
B ovpints RNt racle CMLITE 1024.00 36 .68 s32.07
Customer Hame Location Hame
customer Unassigned Location Unassigned
Tablespace Size Usage Details
Tue, Mar 29, 2005 - Sun, Apr 3, 2005
Date Average Size Allocated Average Size Used Average Size Free

Tue, Mar 29 12:00 Ak 1024 .00 o34 05

Wed, hiar 30 12:00 Ak 1024 .00 480,73

Thu, hiar 31 12:00 A 1024 .00 433.26

Fri, &pr 1 12:00 oM 102400 466 .95

Sat, Apr 21200 A 1024 .00 454 74

Sun, Apr 312000 A 1024.00 509 .63

Oracle Tablespace Reports
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hlar 20

hlar 31
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Database Report Pack (ﬁﬂ]
Tablespace Size Allocated Top 20 Report

invent

The repart showes top 20 tablespaces acrozz all instances soted based on megabytes allocated in the top table with a graph showing
the daily trend for the tablespace selected fram the top table.

Top 20 Tablespaces
Sorted Based on Average Megabhytes Allocated (MB)
Sun, Apr 3, 2005 - Sun, Apr 3, 20045

Systermn Hame I":;?::ge Yendor Tat;:';f::: ce M‘;;';rt:ggs Mi;zrhiggs M‘;\;;rt:ggs
Allocated Used Free
ovpintd CrepintSd Cracle DREYS 1024 .00 533.02 439095
ﬂ:qi ovpintd Ovpints4 Qracle USERS 1024.00 583.02 440.95
ﬂ:q] ovpintd OrepirtSd Cracle SYSTEM 1024.00 59555 42545
ﬂ:q] ovpintd Owpintsd Qracle CWHILITE 1024.00 43459 589.11
ﬂ-Tq] ovpibpta Ovpinpt3 Cracle =B 1024.00 50965
ﬂ ovpihpt3 Orvpibipt 3 Qracle EXAMPLE 1024.00 600 .45 42354
Customer Hame Location Hame
Customer Unassigned Location Unassigned

Average Tablespace Size Allocated (MB)
Tue, Mar 29, 2005 - Sun, Apr 3, 2005

Tablespace Size Allocated (WB)

fu o
I b
m m
= E

hdar 31
Apr o
Apriz
Aprioz

[ Awverage Tablezspace Size Allacated
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Database Report Pack ﬁ/,
Tablespace Size Used Top 20 Report

invent

The report showes top 20 tablespaces across all instances sorted based on megabytes used in the top table with a graph showing the
daily trend for the tablespace selected fram the top table.

Top 20 Tablespaces

Sorted Based on Average Megabytes Used (MB)
Sun, Apr 3, 2005 - Sun, Apr 3, 20045

Systermn Mame  Instance HName Vendor Tat:::fr?: ce M‘L\;g:ﬁzs M‘L\;g:ﬁzs
Allocated Used
ovpibpt3 Crypibpts Ciracle xOB 1024.00
ﬂ ovpibptd Crvpibpt3 Oracle ExAMPLE 1024.00 0046
ﬂ owpintd CrvpintSd Cracle SYSTEM 1024.00 58555
“ ovpintd Cvpint5d Qracle =ERS 1024.00 583.02
% ovpintd CrvpintSd Qracle DRZYS 1024.00 533.02
“ owpiritd CvpintSd Qracle CYMLITE 1024.00 434.89
Customer Hame Location Hame
Customer Unassigned Location Unaszsigned

TableSpace Size Usage Details (MB)
Tue, Mar 29, 2005 - Sun, Apr 3, 2005

fu !
b o)
™ m
= =

hiar 31
Apro
Aproz
Aprosz

.A‘uerage Tablespace Size Fres
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Database Report Pack (ﬁﬂ
Tablespace Size Percentage Used Top 20 Report

invent

The repart shawes top 20 tablespaces acrozz all instances zorted based on percertage tablespace zize uzed in the top table with &
graph showing the daily trend for the zelected tablespace from the top takle.

Top 20 Tablespaces
Sorted Based on Percentage Used
Sun, Apr 3, 2005 - Sun, Apr 3, 20045

Tahlespace Total Space
System Hame Instance Name Yendor Percent Used
Hame Allocated
oyt 3 Owpibpta Orache EXAMPLE 2457600 2932
jf:] avpintd Ovpints4 Oracle S¥STEM 2457500 29.08
ﬂ-Tq] ovpintd Ovpintsd Oracle USERS 2457E 00 28.47
ij] avpintd OrvpintS4 Oracle DRSYS 2457600 26.03
'—G-Tg] ovpintd OrvpintSd Oracle CWNLITE 24576.00 2123
B ovpihpt3 Orvpibpt3 Oracle ¥DE 24576 00 0.00
Customer Hame Location Name
Customer Unassigned Location Unassigned
Tablespace Usage Trend (%)
Tue, Mar 29, 2005 - Sun, Apr 3, 2005
a0.00 1
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A Pl Report Packs

Business Technology

Reporting Solution

Application Application Report Pack:

e WebLogic SPI

e WebSphere SPI
Database Database SPI Report Pack

HP Business Process Insight

BPI Report Pack

HP Internet Services

Internet Services Report Pack

HP Network Node Manager

NNM Event & Availability Report Pack

HP Operations Manager

OVO Report Pack

HP SiteScope

SiteScope Integration Report Pack

IP Telephony e Cisco IP Telephony Call Detail

e C(Cisco IP Telephony Gateway Statistics
MPLS VPN MPLS VPN Report Pack
Networking Infrastructure Usage

e Interface Reporting

e Device Resource Report Pack
LAN/WAN Edge

e Frame Relay (SNMP only)

e ATM (SNMP only)

WAN Core

¢ Frame Relay (multiple switch vendors)
e ATM (multiple switch vendors)
Traffic Profiling

e RMONII

e NetFlow Interface

e NetFlow Global View

e TP QoS Report Pack
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Business Technology

Reporting Solution

Networking (continued)

e (Class-Based QoS

Quality Assurance

e Cisco Ping Report Pack
e Service Assurance
e TP Access Rate

System Resources

System Resource Report Pack
e CPU

e Disk

¢ Logical System

¢ Logical Volume

e Netlf

e Process

Appendix A



B Formulas

Main Package Formulas

If a metric cannot be collected directly from the EPC sub-agent, PI calculates it. The following
table indicates how each metric is calculated.

Metric

How the Metric is Calculated

Instance uptime

Time in minutes the database instance was up

Instance downtime

Time in minutes the database instance was down

Instance unknowntime

Time that is unaccounted for, time when the instance was
neither up nor down = (60 — Uptime — Downtime)

Instance percent uptime

Average Percent Up time of database instance =
(InstUpTime/60) * 100

Instance percent downtime

Average Percent Down time of database instance =
(InstDownTime/60) * 100

Instance percent unknowntime

Average Unknown time of database instance =
((InstUpTime+InstDownTime)/60) * 100

Instance size allocated

Total size of memory allocated by this instance, measured
in megabytes

Instance size free

Amount of memory still free from the total allocated,
measured in megabytes

Instance size used

Amount of memory used, measured in megabytes =
(InstanceSizeAllocated — InstanceSizeFree)

Instance size percent used

Average Percent Instance Size Used = (InstSizeUsed/
InstSizeAllocated) * 100

Instance size percent free

Average Percent Instance Size Used = (InstSizeFree/
InstSizeAllocated) * 100

Oracle Sub-Package Formulas

The following formulae are used to calculate metrics for reports in the Oracle sub-package.

Metric

How the Metric is Calculated

Tablespace Size Allocated

Total size of Tablespace, measured in megabytes
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Metric

How the Metric is Calculated

Tablespace Size Free

Amount of free Tablespace size, measured in megabytes

Tablespace Size Used

Amount of used Tablespace size, measured in megabytes =
(TblSpaceSizeAllocated — ThlSpaceSizeFree)

Tablespace Size Percent Used

Average Percent Tablespace Size Used = (InstSizeUsed/
InstSizeAllocated) * 100

Tablespace Size Percent Free

Average Percent Tablespace Size Used = (InstSizeFree/
InstSizeAllocated) * 100

Segment Size Allocated

Total size of segment, measured in megabytes

Instance Logons

Number of logons for an instance

Instance Transactions

Number of transaction for an instance

I/0

Number of physical I/O operations for a tablespace
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C Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, right-click the object
to open a list of view options. If you are using a web browser to view the report, follow these
steps to change the default view:

1 Click Preferences on the links bar.

Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click the Edit icon next to the table or graph.

o O AN

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Set Time Period.,
hange Constraint Yalues., ..

Select Modes/Interfaces. ..

Change Max Rows, ..
Wiew in nesw Frame

Print: Table. ..

Export Element as CSY...
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ies Table ¥iewer

Polled IP QoS Statistics Data - Input

Cver Previous 6 Hours

IpPrecedence Switched Bytes
u] 105,688

o o o o0

GO0

02,234

O L o e L. | B (O T % B
]

Lo B R |

View Options for Graphs

Switched Plis

GYa

o th OO O O O

G622

L I Y o

=10l

Time Period
Tue Ot 29 0700 A
Tue Ot 29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Ot 29 0700 A
Tue Oct29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Oct 29 0700 A
Tue Oct 29 0700 Ah
Tue Ot 29 0645 Ahd
Tue Oct 29 0645 Al
Tue Ot 29 05495 A
Tue Ot 20 06495 Ahd
Tue Oct 29 0645 Al

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

409.00 1

327207

29540 1

163 60 1

5180 1

0

Sep 17 Sep 21 Sep 25 Sep 29

Add | Everla. .

Remove Overlay

Set Time Period. .,

Change Constraint Yalues. ..
Select Modes)Interfaces. ..

Displayed Data

aarid
Legend
Skyle

- v v v

Change Max Rows., .

Display Data Table

Export Element as C5Y, ..
Misplay Ewverlay Data Table
Export Graph Overlay Data as ©54..,

View in new Frame

Print Graph. ..

Delete Graph
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The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines

Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

Set Time Period. .. 43 s
Change Constraint Yalues. ..

Select Modes)Interfaces. ..

Displayed Data [ % !

Grid k

Legend J /\

Shyle Area

Change Max Rows. .. Stacking Area

Display Dakta Table Bar

Export Element as CSY... Stacking Bar

Display Gwerlay Data Table Pie

Export Graph Overlay Data as C5.., # Flot

Yiew in new Frame Scatter Plot

Prink Sraph. .. AL B S
e B Hi-Lo-Cpen-Close —

—roa  Candle
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

T+

95 Ee0

olure

7170 ¢

Sat Feb 24 06:00 &M EST
Mormal Disconnect (107 j= 74.00

s

04 t L t + t t t t
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected

time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200,00

180.00
120.00
20.00

40.00

Mon 01 Tue 02 iad 02

Ml 2:0q Utilization (H)
I td a3 Utilization (H)
B Ut Threshold

Appendix C



Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924.00 -
9,539 .20
7,154.40

4,769 50

Forecast Minutes

2,364 80

Tho 01 Fri 0Z Sat 03 Sun 04 hon 05 Tue 06 ied OF
D=ys Of The Wieek

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.

200.00
160.00
120.00

20.00

40.00

u]
bon 041 Tue 02 ed O3
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.
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Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

B Under 1 minute

O Between 1 and 5 minutes

[ Between 5 and 30 minutes

[ Between 30 minutes and 2 hours
B Between 2 hours and 12 hours
W Dver 12 hours

If you are looking at data covering several days, you will see multiple pie graphs, one for each
day.
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Display Data Table

This option changes a graph into a spreadsheet.

=1k
* Axis I Average I

Tue Feb 19... 0.509

Tue Feb 19... 0.621

Tue Feb 19... 1.026

Tue Feb 19... 0.362

Tue Feb 19... 1.171

Tue Feb 19... 1.051

Tue Feb 19... 0,254

Tue Feb 19... 0.526

Tue Feb 19... 1,433 %

Tue Feb 19... 0.967

Tue Feb 19... 1.471

Tue Feb 19... 1.308

Tue Feb 19... 1.123

Tue Feb 19... n.93

Tue Feb 19... 1.497

Tue Feb 19... 0.506

Tue Feb 19... 0.725

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

Graph Yiewer |0l x|
Hetwork Response Time
Cizco_04

Tue Feb 19 12:00 AM - Tue Feb 19 11:00 PM

Seconds

Tue 05:00 AM Tue 11:00 PM
— Parerage
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Appendix C



Index

A

ad hoc selector reports, 11

C

change max rows option, 69
collection_manager (command), 20

Common Property Tables, 22, 27
upgrading, 20

custom views of data or property tables, 20

D

Database Oracle Smart Plug-In (SPI), 25
Database Oracle SPI Datapipe, 10, 28
Datapipe Manager, 20

demo package, 27

Display Data Table, 69

displayed data option, 69

E
extracting packages, 27

F

formulas, 65

G
grid options, 69

group_manager (command), 20

Informix, 10

instance downtime, 65

instance logons, 66

instance percent downtime, 65
instance percent unknown time, 65
instance percent uptime, 65

instance size allocated, 65

instance size free, 65
instance size percent free, 65
instance size percent used, 65
instance size used, 65
instance transactions, 66
instance unknown time, 65

instance uptime, 65

L
Launch Point, 11
legend options, 69

M
MS Access, 10
MS SQL Server, 10

o
HP Operations/OM Management Server, 25

OVPI Timer
starting, 23
stopping, 21

P

polling frequency (impact on tablespace statistics),
14

polling policies, 19

R
report linking, 11

reports
view options, 28

S

segment size allocated, 66
style options for graphs, 69
SysRes OVPA Collection Datapipe, 25, 26, 28
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T

Tablespace Physical 10, 14
Tablespace size allocated, 14
tablespace size allocated, 65
Tablespace Size Free, 14
tablespace size free, 66
Tablespace Size Percent Free, 14
tablespace size percent free, 66
Tablespace Size Percent Used, 14
tablespace size percent used, 66
Tablespace Size Used, 14, 66

U
upgrading Common Property Tables, 20
Use Absolute Time, 67

\'}

viewing reports, 28

view in new frame, 68
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We appreciate your feedback!

If an email client is configured on this system, by default an email window opens when you
click on the bookmark “Comments”.

In case you do not have the email client configured, copy the information below to a web mail
client, and send this email to docfeedback@hp.com

Product name:
Document title:
Version number:
Feedback:
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